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Bria Professional Administrator Guide
1 Overview

This manual is intended for a system administrator who is setting up Bria Professional for use by the staff in an 
enterprise. The administrator should be familiar with PBX solutions, telephony and VoIP telephony.

You can deploy Bria Professional by manually configuring via the softphone GUI, or using a provisoning 
server.

Deploying through Manual Configuration
If you have chosen to manually configure Bria Professional, read this entire manual. The general procedure is:

1. Iinstall Bria Professional on your computer and use the Account Settings window and the Preferences 
window to configure Bria Professional to work on your network and with your services. 

2. When you are satisfied with the configuration, push the Bria Professional installation file to all employees.

3. Then either configure the application for each employee, or provide them with a list of settings so that they 
can configure it themselves. Keep in mind that manual configuration does not support login; you must 
make sure that each user’s installation is configured for no login. 

For more information on the documents you should read, go to http://www.counterpath.com/bria.html, click 
Resources, and read the orientation guide.

Deploying through Provisioning
If you are deploying through remote provisioning, read this manual in order to configure on a test computer. 
When you are happy with your configuration, see the Bria Provisioning Guide for information on setting up for 
remote login and remote provisioning. 

For more information on the documents you should read, go to http://www.counterpath.com/bria.html, click 
Resources, and read the orientation guide.
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2 Deploying Bria Professional

2.1 Getting Ready

System Requirements

Microsoft Internet Explorer® 6.0 or later.

Multimedia Device Requirements
Bria Professional requires both speakers and a microphone to make calls. Any of the following configurations 
are acceptable:

• External speakers and microphone
• Built-in speakers and microphone
• Dual-jack multimedia headset
• Bluetooth® multimedia headset
• USB multimedia headset
• USB phone. 

Optimized Devices
Bria Professional is optimized to work with the following:

• Actiontec Internet Phone Wizard
• GN Netcom GN 8120 USB and GN Netcom 8110 USBXP
• Plantronics CS50-USB Wireless Office Headset System
• Polycom® Communicator C100S Wideband USB Speakerphone
• TigerJet RJ11 to USB Phone Adaptor (incorporating the Tiger560C)
• TigerJet USB Phone Set (incorporating the Tiger560C)

Processor Minimum: Intel Pentium III 1.3 GHz or equivalent 
Optimal: Pentium 4® 2.4 GHz or equivalent

Memory 512 MB RAM 

Hard Disk Space 50 MB

Operating System Windows® Vista®
Windows 2000
Windows XP

Connection IP network connection (broadband, LAN, wireless)

Sound Card Full-duplex, 16-bit
2
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• Yealink USB-P1K USB hand phone

Video Cameras
Calls made with Bria Professional will work without a video camera, but one is necessary to allow users to see 
each others’ images. Bria Professional will work with most USB video cameras.

2.2 Logging in
Start Bria Professional as you would any other program: Use the Windows Start menu or double-click the 
desktop icon. The Login window appears. 
 

If, as a system administrator, you are accessing Bria Professional prior to deploying it across your enterprise, 
you can bypass the login for an initial install as follows:

1. Click Sign in on the Login window. Bria Professional will attempt to detect a login server and will fail. The 
Login window will appear again, this time with a Skip button.

2. Click the Skip button. Bria Professional starts.

3. You should immediately choose File > Preferences > Advanced and choose set up the Login fields to match 
your initial setup. Typically, this will be “No login server is available”.

• If you are reading this manual as the first step to deploying a provisioning server, you will later change 
the login setup back to the initial values, as described in the Provisioning Bria guide. 

• If you are configuring Bria Professional manually, then all users must be set up with “No login server is 
available”.
3
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2.3 Configuring Bria Professional
You configure Bria Professional by completing the fields on the Account Settings window and the Preferences 
window. The following table lists configurable features in alphabetical order and specifies the window where 
the feature is configured.

File Transfer

File transfer lets users send and receive files. There are two ways to support this feature: 

• Via content indirection. In this case, files are sent via a SIP account. You must set up a file transfer server. 
See page 17 for information.

• Using the XMPP account. This method does not require special setup, but you must, obviously, be planning 
to create XMPP accounts for your users.

Topic Window Reference

Account credentials (SIP accounts) Accounts > Account (SIP) page 12

Account credentials (XMPP accounts) Accounts > Account (XMPP) page 10

Bandwidth Preferences > Network page 26

Buddy list and privacy rules for SIP 
accounts, storage

Accounts > Storage page 20

Codecs Preferences > Audio Codecs and Video 
Codecs

page 27

Contact list, setting up a corporate contact 
list

page 8

Contact list, storage Preferences > Contact Storage page 32

File transfer (SIP account) Accounts > Topology page 16

LDAP Preferences > LDAP page 31

Logging (troubleshooting) Preferences > Diagnostics page 33

Login Preferences > Advanced page 3, page 34

Media Encryption Accounts > Security page 21

Network (SIP accounts) Accounts > Account (SIP) page 12

Accounts > Topology page 16

Accounts > Advanced page 23

Network (XMPP accounts) Accounts > Account (XMPP) page 10

Presence Accounts > Presence page 18

Privacy (black lists and white lists) Preferences > Privacy page 25

Quality of service Preferences > Quality of Service page 30

Transport Accounts > Security page 21

Voicemail and call forwarding Accounts > Voicemail page 14
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Setting up Accounts
You must set up SIP accounts to allow your users to make phone calls. If the VoIP service provider offers instant 
messaging using SIMPLE, users will also use this account for instant messaging.

You must set up an XMPP account if you are using an XMPP service for instant messaging and presence.

SIP Accounts

Each user requires the following information:

• User name
• Password
• Authorization Name (if applicable)
• Domain

XMPP Accounts

If you use an XMPP service for instant messaging or presence, you will need the following information:

• Jabber ID: user name and domain. For example, jsantos@domainXMPP.com.
• Password.

1. From the Bria Professional menu, choose File > Account Settings. The Account Settings window appears.

2. Click Add > New SIP Account. The SIP Account window appears. Complete the tabs as follows:

• Account: The User Details section will be different for each user. The remaining fields will be identical 
for all users.

• Voicemail: Some of these fields will be different for each user.
• Other tabs: All other tabs will be identical for all users.
See “Account Configuration Reference” on page 9 for details.

3. If you are setting up an XMPP account, click Add > New XMPP Account. The XMPP Account window 
appears. Complete the tabs as follows:

• User Details will be different for each user.
• Other fields will be identical for all users.
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For more information, see “XMPP Account” on page 10.

4. If you have more than one SIP account, decide which is the default and move it to be the first SIP account 
in the list. Similarly, if you have more than one XMPP account, decide which is the default and move it to 
be the first XMPP account. For information on the role that the default account plays, see “How Bria 
Professional Selects an Account” on page 7.

5. Enable the desired accounts. An account must be enabled in order to be used for phone calls, presence, 
instant messaging, subscriptions, and file transfers. An account must be enable for Bria Professional to 
retrieve the buddy list from remote storage associated with that account.

6. On the Account Settings window, click Apply to register the newly added accounts. Click Close when the 
Status column is “Ready”. 

Configuring Global Settings (Preferences)
Use the Preferences window to configure features that apply globally, rather than on a per-account basis. The 
panels that you, as the system adminstrator, should set are:

• Privacy, but only the Corporate panel. Leave the General panel for users to complete.
• Network. You should complete these fields to suit your network.
• Audio Codecs and Video Codecs. You should enable the codecs that are suitable to your environment.
• Quality of Service. If your VoIP service provider supports QoS, you can configure Bria Professional for it.
• LDAP. You can set up a company directory on a server and connect Bria Professional to it via the LDAP 

protocol. The directory will appear in the Directory tab. Information in this tab will update automatically 
whenever the information on the LDAP changes.

• Contact Storage. This panel lets you set up a remote storage system for your contact list via WebDAV or 
XCAP. Note that the storage that is configured here is for the contact list (which contains SIP addresses and 
other addresses), while the storage that is configured on each SIP account is for the buddy list (which 
contains only presence/availability information).

• Advanced. On this panel you should configure only the login server fields; leave other fields for users to 
complete. 

See “Preferences Reference” on page 25.
6



Bria Professional Administrator Guide
2.4 How Bria Professional Selects an Account
Bria Professional determines which account to use for the various activities: phone calls, instant messages, 
presence subscriptions, and file transfers. If you have set up more than one SIP account and/or more than one 
XMPP account, read this section to make sure you set the default account to obtain the desired behavior.

Incoming Phone Calls
The account that an incoming phone call comes in on is controlled by the other party. However, an account must 
be enabled in order for a phone call to be received on it.

Outgoing Phone Calls
The account to use is selected as follows:

• If the user selects a specific account when placing the call, that account is used.
• If not, the phone number SIP address is run through the dial plan process; see “How Dialing Plans Are 

Used” on page 39.
• If that does not select an account, use the domain specified in the SIP address.
• If no domain is specified, use the first enabled SIP account.

Presence Subscriptions and Outgoing Instant Messages
When the user creates a contact, Bria Professional associates each SIP address and each XMPP address with a 
specific account. That associated account is then used for presence subscription requests to that contact (these 
requests are typically initiated as soon as the contact is created) and for instant message sessions that are 
initiated by the user. The account to use is selected as follows:

• Match the domain of the contact's address to the domain portion of an account of the same type (i.e., match 
a SIP address to a SIP account). For example, sip:kpereira@domainA.com will match the  “domainA.com” 
SIP account in the account list.

• If no match is made, use the first “useable” account in the account list. An account is useable if it is enabled 
and of the correct type (SIP or XMPP) and it is set up for presence (if a SIP account; XMPP accounts are 
always set up for presence).

The user can change this initial selection for any contact by displaying the Contact Profile and clicking the 
Advance button. However, if you have set up the default accounts appropriately, the user should not have to 
change this selection.

If a user has problems with presence for a particular contact, view this Advanced dialog and make sure the 
Account is set correctly. 

• If there is no presence subscription (Account specifies “Unavailable”), then select an appropriate account.
• If an account is selected but presence information is not being received, try selecting a different account. 

The presence subscription should be sent via the account that “owns” the address; proxies may not pass 
through addresses that do not belong to them. 
7
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2.5 Creating a Contact List
Typically, users will want to create contacts in order to easily make phone calls, send IMs and transfer files. You 
can provide a file (for example, the company contact list) that your users can import into their individual 
softphones. This file can be:
• A comma-separated file. Use this method to import from a Microsoft® Excel® file. You will first have to 

set up the file; see below. 
• A Microsoft® Outlook® or Microsoft® Exchange contact list (a *.pst file). 
• A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an email.

Setting up an Excel File for Import

1. Remove any introductory text or headings from the top of the file. (You can keep text at the end of the file; 
it will be ignored during the import.)

2. Insert a blank row as the first row, then insert the headings that Bria Professional will use to interpret the 
meaning of each column. The columns can be in any order. The most popular headings are:

• display-name
• entry_id
• given_name
• surname
• postal_address.
For a complete list of headings, see “Glossary” on page 46.

3. Save the file as *.csv.

To test out the import process, see the procedure in the Address Book chapter of the Bria Professional User 
Guide.
8
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3 Account Configuration Reference

The Account Settings window lets you configure features that apply on a per-account basis. (The preferences 
window lets you configure features that apply across all accounts.) 

3.1 Accounts Settings Window
Choose File > Account Settings from the menu. The Account Settings window appears, showing all the 
accounts set up. 

You can:

• Add or remove an account. 
• Enable one or more accounts. 
• Set one default for each account type (SIP and XMPP). See “How Bria Professional Selects an Account” on 

page 7 for information on the importance of the default account.
• Set or change the properties of an account. These properties control how Bria Professional interacts with 

your network, and are set individually for each account. Click the Properties button, then see the following 
pages for details. 
9
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3.2 XMPP Account

Table 1: XMPP Account Properties – Account

Field Description
Account name If desired, change the account name to something that is meaningful to you. 
Protocol Read-only. Always specifies XMPP.

User Details
Jabber ID Typically the account number for the softphone account plus the domain. For example, 

kpereira@domainXMPP.com. 
Password
Display name This name is displayed in the Bria Professional display.

Other parties will see this name they are when connected to the user.

Advanced
Port selection Configures the port to use. 

If you choose “User selected”, complete the Connect port field. 
Connect port Complete only if Port selection is set to “User selected”

A red dot appears here to alert you 
when the Jabber ID field is blank or 
when the Jabber ID is incomplete. The 
alert disappears after you type “@” in 
the Jabber ID.

A red dot appears here to alert you 
when the Password field is blank. 
The alert disappears after you enter 
a password.
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Outbound proxy The value in Jabber ID and in this setting may be used by Bria Professional to compose a valid 
jid:
• If Jabber ID=bob@ABC.com and Outbound proxy is empty, jid=Jabber ID: bob@ABC.com
• If Jabber ID=bob@ABC.com/home and Outbound proxy is empty, jid=Jabber ID: 

bob@ABC.com
• If Jabber ID=bob@ABC.com and Outbound proxy=XYZ.com, ignore the Outbound proxy; 

Jabber ID=bob@ABC.com
• If Jabber ID=bob@ABC.com and Outbound proxy=IP address or host address, jid=Jabber 

ID. (IP address is used as the outbound proxy).
• If JabberID=bob and Outbound proxy=ABC.com, jid=bob@ABC.com.

Resource Optional resource, as specified in RFC 3920. For example "/home". If this setting is blank and 
the Jabber ID includes a resource, the value from that ID is used. If both are specified, the value 
from this Resource field is used.
If no resource is specified, the XMPP server will assign a temporary resource.

Priority The priority, as per RFC 3921. The default is 0.

Table 1: XMPP Account Properties – Account

Field Description
11
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3.3 SIP Account Properties – Account

Table 2: SIP Account Properties – Account

Field Description
Account name If desired, change the account name to something that is meaningful to you. 
Protocol Read-only. Always specifies SIP.

User Details
User ID Typically the account number for the softphone account plus the domain. For example, 

kpereira@domain.com.
Password
Display name This name is displayed in the Bria Professional display.

Other parties will see this name they are when connected to the user.
Authorization name Typically not used in an enterprise environment. This anem is useful if, for example, you 

allow user IDs that are short and therefore easy to guess. The authorization name is used in 
place of the user name to register the account with the SIP registrar. 

Domain Proxy
Register with domain and receive 
calls

Typically, this field is checked. 
A situation in which this field is unchecked is, for example, if your level of service does not 
include the ability to receive incoming calls. In this case, turning this field on may cause 
registration to fail (when you close the Account Properties window), meaning that your Bria 
Professional cannot register..

A red dot appears here to alert you 
when the User ID field is blank or 
when the User ID is incomplete. 
The alert disappears after you type 
“@” in the User ID.
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Send outbound via • Domain: If your VoIP service provider requires that traffic be directed to proxies that are 
discovered via the domain.

• Proxy Address: If your VoIP service provider has an outbound proxy address and requires 
that you provide the address to Bria Professional. For the address enter a domain name (for 
example, domain.com) or an IP address (for example, 123.456.789.012). 

If you are using Bria Professional in a test lab, it is possible that neither of these settings is 
suitable; see page 24 for a third way to direct traffic. 

Dial Plan The default plan is:
#1\a\a.T;match=1;prestrip=2;
See “Dial Plan” on page 39. 

Table 2: SIP Account Properties – Account

Field Description
13
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3.4 SIP Account Properties – Voicemail

These settings let you configure client-side voicemail features.
Your IP PBX may also provide the ability to configure voicemail (server-side handling). An incoming phone 
call first goes through server-side handlers and then through the client-side handlers. Keep in mind that the 
fields on this Voicemail tab are not writing to the server; they are configuring a second, separate handler.
You must decide how you want phone calls to be handled: by the server only, by the Bria Professional client 
only, or by both. Instruct your users accordingly.
If you decide to allow both, you must make sure that your users understand how the server-side and client-side 
voicemail configuration must be synchronized to work together. You must also check what the server-side 
settings are and make sure you enter compatible information in Bria Professional. 
 

Table 3: SIP Account Properties – Voicemail

Field Description
Check for voicemail Choose the setting appropriate to your IP PBX:

• On: Bria Professional will subscribe to be notified when there is a voicemail for you. 
• Off: the IP PBX may be set up to advise Bria Professional when there is a voicemail 

for you.

Voicemail is controlled by your IP PBX, not by Bria Professional. 
Number to dial for checking voicemail This is the number that will be called when a user clicks the Check for voicemail icon 

on the softphone, in order to connect to voicemail and listen to messages. 
If you leave this field empty, then this icon will not work; users will have to manually 
dial this number in order to connect to voicemail.

Number for sending calls to voicemail This is the number that incoming calls will be forwarded to if they are unanswered after 
the specified interval (below).

Send calls to voicemail if unanswered To send to voicemail after the specified number of seconds.
Your IP PBX may also provide a similar feature that is set up outside of Bria 
Professional. If so, make sure you do not enter competing information in Bria 
Professional and in the IP PBX’s user interface. For example, if you turn off this field, 
make sure the same feature at your service provider is also turned off. Otherwise, all 
your calls will continue to be forwarded.
14
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Always forward to: To always forward phone calls received on this account.
Enter the address to forward to, but leave the checkbox cleared (the individual user will 
click it when desired). Phone calls received on other accounts (if you have them) are not 
affected by enabling this field for this particular account. 

When on the phone, forward to: To forward only when you are on another phone call.
Enter the address to forward to, but leave the checkbox cleared (the individual user will 
click it when desired). Phone calls received on other accounts (if you have them) are not 
affected by enabling this field for this particular account.
Your service provider may provide a similar feature that is set up outside of Bria 
Professional. If so, your users must make sure they do not enter competing information 
in Bria Professional and in the service provider’s user interface. For example, if they 
turn off this field, make sure the same feature at your service provider is also turned off.

Table 3: SIP Account Properties – Voicemail

Field Description
15
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3.5 SIP Account Properties – Topology

Table 4: SIP Account Properties – Topology

Field Description

Firewall Traversal
IP Address This setting controls how your IP address is presented. 

• Discover global address: Let Bria Professional determine your public IP address. 
• Use local IP address: use the IP address of the Bria Professional computer.

The recommended setting is Discover global address.
STUN Server This setting specifies the STUN server to use.

• Discover the server: Choose this option to let Bria Professional find the address of a STUN server. 
• Use this server: To use a different STUN server. For the address enter a domain name or an IP 

address. 

The recommended setting is Discover server.
Enable ICE ICE optimizes traffic and may help with firewall traversal.

Typically, ICE is enabled. However, you may need to disable it if  have implemented a firewall 
traversal solution that is not compatible with ICE enabled. 

XTunnels
Use XTunnels • Automatic: Use Xtunnels when Bria Professional detects a firewall that prohibits communications. 

This is the recommended setting if your service provider has an XTunnels server.
• Always: Always use XTunnels.
• Never: Do not use XTunnels. This is the correct setting if your service provider does not have an 

XTunnels server.
Server Address Optionally, specify the name or IP address of the XTunnels server to use.

• If the field is completed, Bria Professional will use that server.
• If it is blank, Bria Professional will perform a DNS lookup to discover the server.

Username and Password Check this box to use the username and password from your SIP account in order to log into the 
XTunnels server.
Otherwise, uncheck this box and complete the Username and Password fields.
16
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Configuring the File Transfer Server
If you are supporting file transfer via content indirection over a SIP account, you must set up a server. You do 
not need to set up any servers for file transfer over an XMPP account; that kind of file tranfser is handled peer-
to-peer.

It is recommended that the file transfer server be within your enterprise firewall. 

File transfer via content indirection is performed over HTTP or HTTPS. You must:

• Configure the HTTP server to allow PUT. If you enable WebDAV on an HTTP server, then PUT is 
automatically enabled.

• Create the root folder on the HTTP server. 
• Set the File transfer server field on the Topology panel.

Range of Ports on Local Computer
Range of ports used on 
local computer

The appropriate setting depends on your computer setup:
• Checked: If your computer is behind a restrictive firewall that only allows specific port ranges to 

be used. Enter the range of ports to use for your SIP account. (You must also open those ports on 
your firewall; refer to applicable firewall documentation for information.)

• Unchecked: If your computer is not behind a restrictive firewall.   

File Transfer
File transfer server Optional. If you are supporting file transfer via content indirection on a SIP account, specifies the 

URL of the file transfer server where files your users send will be stored before they are retrieved by 
the recipient.
For example, http://AcmeCorp/FileTransfer, where AcmeCorp is the server and FileTransfer is the 
root folder.
You must set up this server if you want to send files. See below. You do not need to set it up in order 
to receive files.

Table 4: SIP Account Properties – Topology

Field Description
17
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3.6 SIP Account Properties – Presence

This tab lets you set up to share presence information with contacts who have addresses associated with this SIP 
account. (For information on account association, see “How Bria Professional Selects an Account” on page 7). 
Note that you do not have to set up to share presence information on an XMPP account.

Table 5: SIP Account Properties – Presence

Field Description
Mode • Disabled: Presence is not supported.

• Presence Agent. 
• Peer-to-Peer.

Poll time The factory setting is 300.
Refresh interval The factory setting is 3600.
18
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How Presence Subscriptions Work
The following chart illustrates how the sharing of presence status occurs. This chart illustrates a peer-to-peer 
subscription, but the same principle applies when a presence agent is used.
19
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3.7 SIP Account Properties – Storage

These settings let you set up a remote storage system for the buddy list for this SIP account. (Note that the 
buddy list for an XMPP account is always stored on the XMPP server; no configuration is required).

Table 6: SIP Account Properties – Storage

Field Description
Storage method The storage method to be used for the buddy list and presence rules. The file can be stored 

locally or both locally and on a remote computer.

Server Settings
Use SIP credentials Check this box to use the username and password from your SIP account in order to log into 

the storage server.
Otherwise, uncheck this box and complete the Username and Password fields.
Not used for “Local”.

Root URL URL of an appropriate root folder on the remote server.
Not used for “Local”. The factory setting is https://webdav.$domain$/webdav/$username$/

WebDAV poll time Enabled only for WebDAV. The time that elapses between polling for new data from the 
remote server.
The factory setting is 600.
20
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3.8 SIP Account Properties – Security

You can set up Bria Professional for the type of security (encryption) you want for incoming and outgoing calls.
Bria Professional supports:
• Signaling encryption using TLS
• Media encryption using SRTP.

Setting up for Security outside of Bria Professional
When using TLS, you must have the root certificate that signs the proxy's chain of certificates. In most cases, 
the root certification will already be installed. Procedures for the exchange of certificates are outside the scope 
of this documentation. The certificates must be stored on the Bria Professional computer, in the root certificate 
store.
Setting up the root certificate on your computer ensures that the connection to the proxy is TLS secure (the first 
hop). Any proxy in the chain (between you and the caller) that does not support TLS may cause an insecure link 

Table 7: SIP Account Properties – Security

Field Description
Signaling Transport • Automatic: Bria Professional sets up the transport based on the capabilities of the 

network and the Bria Professional computer. Choose this option if you do not care which 
transport is used.

• TCP: This transport provides no signaling security. 
• UDP: This transport provides no signaling security. 
• TLS: Choose this option to request signaling encryption or both signaling and media 

encryption.
Media Encryption See Table 8 on page 22.

The factory setting is Make unencrypted calls, accept all calls.
21
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in the chain. Therefore, if the other party is outside your domain, you cannot be completely sure that the call is 
secured at the signaling level, which means that you cannot be sure that it is secured at the media level.
When a call with both signaling and media encryption is established, Bria Professional displays the encryption 
icon ( ). This icon indicates that the call is secure between each caller and their proxy (first and last hop) and 
that it may or may not be secure for other hops.

Setting up for Security within Bria Professional
The options for media encryption are described in the following table.

Table 8: Media Encryption Options

Option How Outgoing Calls are Handled How Incoming Calls Are Handled
Make and accept only 
encrypted calls

Bria Professional will place all calls with TLS. The 
call INVITE will specify SRTP media encryption.
If the correct certificates are not in place or if the 
other party does not accept encrypted calls, the call 
will fail.

Bria Professional will only accept INVITEs that 
are for  encrypted calls.
If Bria Professional receives a call INVITE that is 
not encrypted, the call will be rejected.

Prefer to make and 
accept encrypted calls

Bria Professional will place all calls with TLS. The 
call INVITE will specify SRTP media encryption.
If the correct certificates are not in place or if the 
other party does not accept encrypted calls, the call 
will fail. Bria Professional will then place the call 
without encryption.

Bria Professional will accept INVITEs for both 
encrypted and unencrypted calls. 

Make unencrypted calls, 
accept all calls

Bria Professional will place only unencrypted 
calls.
If the other party does not accept unencrypted 
calls, the call will fail.

Bria Professional will accept INVITEs for both 
encrypted and unencrypted calls.

Do not allow encrypted 
calls

Bria Professional will place only unencrypted 
calls.
If the other party does not accept unencrypted 
calls, the call will fail.

Bria Professional will only accept INVITEs that are 
for unencrypted calls.

If Bria Professional receives a call INVITE that is 
encrypted, the call will be rejected.
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3.9 SIP Account Properties – Advanced

s

Table 9: SIP Account Properties – Advanced

Field Description

Register Settings
Reregister every The time interval between Bria Professional’s attempts to reregister in order to refresh the account 

registration. A value of zero means not to reregister after the initial registration.
This value is placed in the “Expires” header field of the REGISTER message.
The factory setting is 3600.

Minimum time If the reregistration fails, Bria Professional will wait this amount of time, then attempt to 
reregister. If the second attempt fails, Bria Professional will wait twice this time and try again, 
then four times this time, and so on, until reregistration succeeds.
The factory setting is 20.

Maximum time This is the maximum wait time between attempts to reregister. Once this maximum is reached, 
Bria Professional will wait this time for all subsequent attempts.
For example, the min. time is 20 secs, the maximum time is 120 secs. Bria Professional will 
attempt to reregister as follows:
• Wait 20 secs.
• Attempt to connect. 
• If fail, wait 40 secs.
• Attempt to connect.
• If fail, wait 80 secs.
• Attempt to connect.
• If fail, wait 120 secs (the maximum)
• Attempt to connect.
• If fail, wait 120 secs, and so on.

The factory setting is 1800.
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Timers
Enable session timers
Default session time

A session timer is a mechanism to detect whether a call session is still active from the signaling 
point of view. When the timer expires, a refresh is sent from one party to the other. The timer is 
then reset.
• Turn on to enable session timer. Enter a value in Default session time. The factory setting is 60.
• Turn off to disable session timer; refreshes will never be sent.

Session timer preference This field specifies your preference for which party should send the refresh. The preference is not 
a guarantee that the refresh will be performed by the specified party. The choices are:
• None: No preference.
• Local refreshes: Your computer sends.
• Remote refreshes: The other party sends.
• UAC refreshes: The user agent client (the party that initiated establishment of the 

communications) sends.
• UAS refreshes: The user agent server (the other party) sends.

Send SIP keep-alives Typically on, to instruct Bria Professional to send SIP keep-alive messages in order to maintain a 
“pinhole” through your firewall for SIP messaging.

Use rport Typically on.
Send outgoing request 
directly to target 

When checked, requests with a complete URI (user@ABC.com) go to ABC.com and the “Send 
outbound via” field on the Account tab (page 12) is ignored.
Typically off. This field is intended for test labs and may cause problems in a NAT environment.

Table 9: SIP Account Properties – Advanced

Field Description
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4 Preferences Reference

Choose File > Preferences. The Preferences window appears. 

The Preferences panels let users control the way that they work with Bria Professional. It also contains fields to 
configure features that apply globally, rather than on a per-account basis. 

4.1 Preferences – Privacy
On this panel, you should complete only the Corporate tab. 

It is very useful to enter your own corporate domain in the list of allowed domains, so that users automatically 
accept presence subscriptions from each other, and do not get bombarded with presence (availability) requests.

If you enter a domain in this list, 
people in that domain will 
automatically be allowed to see your 
availability online.
You will no longer see Presence 
Request dialogs from these people in 
this domain. 
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4.2 Preferences – Network

On this panel, complete the network connection speed section and Preserve bandwidth field to suit your 
environment. Leave the Video Image Size for the user to complete.

Field Description

Network Connection Speed Select the type of network connection for your computer.
The sliders move to show the bitrate that will be used for sending and receiving. These rates are 
typical rates for the selected configuration.
If you know that your computer and network can handle a faster sending speed, click Custom 
and move the slider.
It is recommended that you not change the receiving speed.
You will know that you have set the sending speed too high if:
• The remote video shows black areas or is slow or jerky.
• The remote audio is garbled.

You will know that you have set the sending speed too low if the audio is good but the video is of 
poor quality (grainy).

Preserve bandwidth When this feature is on, Bria Professional stops sending audio when you are not talking.
When this feature is off, Bria Professional always sends audio, which uses more bandwidth but 
may result in better call quality.
Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may want to 
turn it on. 
26



Bria Professional Administrator Guide
4.3 Preferences – Audio Codecs

This panel shows all the codecs that are included in the retail version of Bria Professional. You can enable or 
disable codecs as desired. 

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, Bria 
Professional automatically chooses the best codec based on the other party’s capability, the available bandwidth, 
and network conditions.

You cannot change the properties of any codecs.

About Codecs
Audio codecs describe the format by which audio streams are compressed for transmission over networks. 
Codecs can be categorized as either narrowband or wideband:

• Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs have a 
sampling rate of 8 kHz.

• Wideband codecs work with high bandwidths and result in better audio quality. However, they do not work 
with PSTN. These codecs have a sampling rate of 16 kHz.
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Supported Codecs
Bria Professional supports a wide range of codecs. See the table.

Codec Narrowband Wideband Royalty-bearing
Included in 
Retail Bria 

Professional

AMR Wideband (G.722.2)

Broadvoice-32

Broadvoice-32 FEC

DVI4

DVI4 Wideband

EVRC

G.711aLaw *

G.711uLaw *

G.722

G.723

G.726

G.729 *

GSM

iLBC

L16 PCM Wideband

Speex

Speex FEC

Speex Wideband

Speex Wideband FEC

* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call. 
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4.4 Preferences – Video Codecs

Video codecs describe the format by which video streams are compressed for transmission over networks. Some 
codecs require less bandwidth than others, but may result in lower video quality.

You can enable or disable codecs as desired. 

With only one codec enabled, all calls made will use that particular compression format. With more than one 
codec enabled, Bria Professional automatically chooses the best codec based on the other party’s capability, the 
available bandwidth, and network conditions. 

You cannot change the properties of any codecs.

Supported Codecs
   

Codec Royalty-bearing
Included in 
Retail Bria 

Professional

H.263

H.263+ 1998

H.264 (unified)
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4.5 Preferences – Quality of Service

The Quality of Service panel lets you request a specific transport service for audio, video and signaling traffic.

There are two types of services. The service to use depends on what your VoIP service provider supports:

• GQoS, which is available for audio and video.
• DSCP (also known as ToS), which is available for audio, video and signaling.

In a network that has the default configuration, the recommended value for audio is 46, because “46” is the 
standard marking for audio.

Bria Professional supports 802.1p QoS packet tagging. If you set up for QoS, Bria Professional will include the 
specified information in the packets that it sends to the network provider. Whether the packet is delivered with 
the specified service depends on whether your broadband router and the network provider between you and the 
other party supports multiple transport services. In other words, whether each network provider reads the QoS 
information and prioritizes packet delivery based on the requested service. 
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4.6 Preferences – LDAP
If you have access to an LDAP directory, you can configure Bria Professional to automatically download the 
directory and display it in the Directory tab in the Address Book. 

Field Description

LDAP

Enable LDAP Click to enable. Assuming that the other fields in this section have valid information, the directory 
data will be retrieved and displayed in the Directory tab in the Address Book.
The data will be updated as specified in the query polltime.

Other other fields Complete these settings to configure Bria Professional to locate and subscribe to your LDAP 
server.

LDAP Attribute Mapping

All fields In this section, map the names of the attributes that are in your LDAP directory to the 
corresponding fields in Bria Professional. The field label is the Bria Professional field. The field 
box specifies the attribute name.
Be careful with this mapping because when users create a contact from an LDAP entry, the phone 
number is mapped into the different contact methods in the contact. For example, the phone 
number in “Softphone” will appear as a softphone number contact method in the contact, and Bria 
Professional will allow/disallow certain actions (for example sending an IM) to that phone 
number.
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4.7 Preferences – Contact Storage

These settings let you set up a remote storage system for user contact lists via WebDAV or XCAP. (The contact 
list is always stored locally, even when you set up for remote storage.) Note that the storage that is configured 
here is for the contact list (which contains SIP addresses and other addresses), while the storage that is 
configured on each SIP account (page 20) is for the buddy list (which contains only presence/availability 
information).
The contact list is automatically loaded at startup, and is loaded even if no accounts are enabled.

Table 10: SIP Account Properties – Storage

Field Description
Storage method The storage method to be used for the Contact list file. The file can be stored locally or both 

locally and on a remote computer.
Username and password The user name and password to log into the storage server.

Not used for “Local”.
Root URL URL of an appropriate root folder on the remote server.

Not used for “Local”. The factory setting is https://webdav.$domain$/webdav/$username$/
WebDAV poll time Enabled only for WebDAV. The time that elapses between polling for new contact data from the 

remote server.
The factory setting is 600.
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4.8 Preferences – Diagnostics

This panel lets the user enable logging to files. Logging uses computer resources, so you should make sure your 
users only enable it when you or a customer support representative instruct them to do so.

Configuring
You should configure the folder where logging files will be saved. You should also make sure the logging is 
initially disabled.

Activity on Bria Professional will be logged to.csv files in the specified folder. A new set of files is started each 
time the user logs on. In order not to create large files when logging (which may create computer problems), 
make sure your users do not remain logged on indefinitely when logging. They should occasionally exit and 
restart Bria Professional.

You can delete log files from the specified folder as you would any other data file.

Sending Files to Customer Support
If requested by a customer support representative, you can:

• Open the logging folder and then open a log file using a text editor. 
• Email the logs in the specified folder to customer support: Click Send logs to customer support. A dialog 

box appears showing all the logs. Select files and click Open; the selected files are sent and the dialog box 
closes.
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4.9 Preferences – Advanced

Configuring the Login Option

If You Are Deploying through Manual Configuration

If you are configuring Bria Professional manually, then all users must be set up with “No login server is 
available”. The other login fields are ignored.

Field Description

Reduce echoes from speakers Turning this feature on improves sound quality. This feature is typically on.

Use slower but more compatible video format Turning this field on may improve performance when running Bria Professional 
on older hardware.

Auto Answer Calls

Auto answer incoming calls
• after ringing first
• without ringing

From the first set of radio buttons, choose how quickly you want Bria 
Professional to auto-answer an incoming call.

Auto answer with From the second set of radio buttons, choose how you want to handle your own 
video (the video you send), if the other party has placed a video call:
• Auto answer with audio: Your video is not sent. However, if necessary, the 

video panel opens so you can view the other person’s video.
• Auto answer with audio and video: Your video is sent. If necessary, the video 

panel opens, showing both your video and the other person’s video.

Login Server

See below
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If You Are Deploying through Provisioning

If you are reading this manual as the first step to deploying a provisioning server, then leave the default values:

• Choose “Automatically detect the login server through DHCP”.
• Check “Number of times a user can skip”.
• Enter -1 in the field. 

With these settings, login will be handled in one of two ways:

• While you are exploring your deployment options on a test computer and do not yet have a login server set 
up, you will skip login and manually set up your accounts. See “Logging in” on page 3. 

• When you have deployed the login server, then login will occur as described in the Provisioning Bria 
Professional Guide. 
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A Configuration Form
Dialog Field Account 1 Account 2

Main Page Default Account

Account Type

Account > 
Account Tab

Account Name

User ID

Password

Display name

Authorization name

Register with domain

Send outbound via

Dial plan

Account > 
Voicemail Tab

Check for Voicemail

Number to dial for checking voicemail

Number for sending calls to voicemail

Send calls to voicemail if unanswered 

seconds

Always forward to

When on phone, forward to

Account > 
Topology Tab

IP address

STUN server

Enable ICE

XTunnels  - Use

XTunnels  - Server address

XTunnels  - Credentials (radio button)

XTunnels  - Username

XTunnels  - Password

Range of ports (chackbox)

Range of ports (from, to)

File transfer server

Account - 
Presence Tab

Mode

Poll time

Refresh interval
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Storage Tab Storage method

Credentials (radio button)

Username

Password

Root URL

WebDAV poll time

Account > 
Security Tab

Signaling Transport

Media Encryption (for TLS)

Account > 
Advanced Tab

Reregister every

Min. time

Max. time

Enable session timers

Session timer preference

Default session time

Send SIP keep-alives

Use rport

Send outgoing request directly to target

Preferences > 
Audio Codecs

Enabled codecs 
_______________  _______________

_______________  _______________

_______________  _______________

_______________  _______________

_______________  _______________

Preferences > 
Video Codecs

Enabled codecs 
_______________  _______________

Preferences > 
Quality of Service

Signaling Qos

Audio Qos

Video Qos

Dialog Field Account 1 Account 2
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Preferences > 
LDAP

Enable

Server

Authentication method

Username

Credential

Root DN

Search expression

Query timeout

Maximum records

Query polltime

Display name

First name

Last name

Home number

Work number

Mobile number

E-mail

Softphone

Jabber

Preferences > 
Contact Storage

Storage method

Username

Password

Root URL

WebDAV Poll time

Preferences > 
Advanced

Login Server 

Number of times (checkbox)

Number of times (field)

Dialog Field Account 1 Account 2
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B Dial Plan
When a call attempt is made, the call input (what you type, select or drag onto the Call display) is processed to 
select the SIP account to use and to modify the input if that is required to ensure that the call gets placed 
successfully. This ability to select an account and modify the input relies on the existence of a “dial plan” for 
each account.

B.1 How Dialing Plans Are Used
When you make a call, Bria Professional takes the phone number (the input) and performs the following:

Cleanup

Input is cleaned up by removing spaces, dashes, open brackets, and close brackets. Cleanup allows Bria 
Professional to support calls placed using contacts from a contact list, including Microsoft® Outlook®.

Matching

The input is compared to the patterns defined by the dial plan for each enabled account. Each account has one 
dial plan, and each dial plan has one or more patterns.

• When a match is found between the input and the pattern, the account that this pattern belongs to is selected 
and the transformation for this pattern is performed.

• If no match is found, the default account is selected and no transformation is performed.

For details on matching see “How the Input Is Processed” on page 42.

Transformation

The selected transformation is performed.

Place Call

Then the call is placed using the transformed input. 

The Default Dial Plan
The default dial plan is:

#n\a\a.T;match=1;prestrip=2;

where #n is the account prefix (#1 for the first account in the list (proxy0), #2 for the second account (proxy1), 
and so on).

If the input is the account prefix and the number, then the Account for this dial plan is selected. The account 
prefixed is stripped from the number before the call is placed.

If all Accounts use this dial plan, then the behavior is as follows: if the input includes the account, then that 
account is used. In other words, you can force selection of a specific account by including the account prefix. If 
the input does not include #n, then the default account is used.
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B.2 Dial Plan Syntax
In Bria Professional, the dial plan establishes the expected patterns of characters for a telephone number or 
softphone address, and allows for modification (transformation) of input based on the match to a pattern. The 
dial plan has the following syntax:

pattern[|pattern];match=1;<transformation>=<value>;[match=2;
<transformation>=<value>;]

Where:

• Items in [ ] are optional. 
• Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The 

pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1.
• Match; Transformation: A pair that identifies the pattern number to compare with the input, and the 

transformation to perform on the input when a match is obtained. The transformation is optional (meaning 
that if there is no transformation for a pattern, then the input that matches this pattern is not transformed). 
One or more pairs.
“match=” is a literal. “n” identifies the pattern. “transformation=” is replaced by a keyword, see below. 
“value” is replaced by a value.

Spaces are allowed only in the <value> items. 

Example
\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;

where:

• \a\a.T is the first pattern.
• xxxxxxxxxx; is the second pattern.
• match=1;prestrip=2; is the first match-transformation pair.
• match=2;pre=8; is the second match-transformation pair.

Pattern

Valid Content
The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular 
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules 
apply. For this reason, there are some special cases, included in the table below.

The following table describes the most common elements. As mentioned, all regular expression elements are 
supported.

Remember that dialing plans are applied after the input has been cleaned up (page 39)!

Element Origin Description

0 1 2 3 4 5 6 7 8 9  Literals Literal digits, used as is. 

# * a to z Literals Literal characters, used as is. Special cases: 
• The literal x character is represented by \x.
• The literal t character is represented by \t.
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Timers
There are two timers:

• T timer is 4 seconds.
• The long timer is 20 seconds.

These timers are used in input comparison, as described in “How the Input Is Processed” on page 42.

Transformation Keywords

Order of Transformations
These transformations are always performed in the following order (the order in which the transformations are 
entered in the dial plan is not significant):

prestrip  >  poststrip  >  pre >  post  >  replace

x Digit map rules Wildcard for any single digit, 0 to 9. 

\a Regular 
expression rules

Wildcard for any single alphanumeric character.

[digit-digit] Regular 
expression rules

A digit within the specified range.

[character-
character]

Regular 
expression rules

A character within the specified range.

[digit1, digit2, 
digit3]

Regular 
expression rules

One of the characters in the collection.

. Digit map rules Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or 
more times, which means this pattern matches three or more digits (not four or more 
digits)! Use of this element results in a pattern with “minimum requirements”. 

T Digit map rules A timeout period will take place before automatic dialing starts.
The T timer forces Bria Professional to wait after a match is made. This timer should 
always be included in these situations:
• Any pattern that uses the . (dot).  For example, if the pattern is xxxx. then adding a 

timer lets you type three or more digits. If there is no timer, then as soon as you type 
three digits, Bria Professional makes the match as soon as you type three digits. 

• Any dial plan that has two patterns that are similar in elements but different in length. 
For example, if one pattern is xxx and the other pattern is xxxxxxx, then adding the 
timer lets you continue typing past three digits, in order to get a match on the second 
pattern.

In this situation, the T timer should be included in the shorter pattern. 

Keyword Description

prestrip Strip the first n characters from the input before placing the call.

poststrip Remove n number of characters from the end of the input before placing 
the call.

pre Add the specified account prefix to the input before placing the call.

post Attach the specified postfix to the input before placing the call.

replace Replaces the input with the specified string before placing the call.

Element Origin Description
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B.3 How the Input Is Processed

Comparing Input to the Dial Plan Patterns
The input is compared to each dial plan in turn, starting with the first listed account. The process is slightly 
different depending on how the call is placed:

• If the input was dragged or selected, then the entire input is compared to each dial plan. If a complete match 
is found, then that account is selected and the associated transformation is performed. If no match is found, 
the default account is selected and no transformation is performed. 

• If you are typing the input, the digits are compared one by one as they are entered. The comparison will 
result in one of the types of matches described in the table below.

It is possible for the same input to get matched to different dial plans depending on whether the input is entered 
on the fly or dragged. It is important to keep this in mind when designing dial plan patterns. 

Results of the Comparison
Type of Match Conditions Result if You Press 

Enter or Dial Result if You Stop Typing

Partial match The characters typed so far follow the pattern but 
there are not yet enough characters for a pending 
or complete match.

The default account is 
selected. No transformation 
is performed.

If you stop typing for the long 
timer length (20 seconds), then 
the default account is selected. 
No transformation is 
performed on the characters 
typed so far.

Pending match • The pattern has no . (dot) but does have the T 
timer. There is a perfect match.

• The pattern has a . (dot) and the T timer. The 
minimum requirements are met.

This pattern's account is 
selected and the 
transformation is 
performed.

If the T timer expires, this 
pattern's account is selected 
and the transformation is 
performed.

Complete match • The pattern has no . (dot) and no T timer. 
There is a perfect match.

• The pattern has a . (dot) but does not have the 
T timer. The minimum requirements are met.

This pattern's account is 
selected and the associated 
transformation is 
performed.

This pattern's account is 
selected and the associated 
transformation is performed.

No match The characters typed do not match the patterns 
for any dial plan.

The default account is 
selected and no 
transformation is 
performed.

Nothing happens even after the 
T timer and long timer have 
expired.
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B.4 Examples

Example 1
\a\a.T|xxxxxxx.T;match=2;pre="9"

This simple example shows how to differentiate between a PSTN number and a softphone address, and how to 
add a “9” dialing prefix only to the PSTN number. 

Example 2
3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"

Example 3
#1xxxxxxxT|#19xxxxxxx|xxxxxxxT|9xxxxxxx|;match=1;prestrip=2;pre=9;match=2;
prestrip=2;match=3;pre=9;

This example assumes that the dial plan belongs to the first account. 

The dial plan is slightly trivial, because it does not cover all the situations that a dial plan should be designed for 
(local calls, long-distance calls, international calls, and so on for the locale).

3xxT The first pattern is any three-digit number beginning with 3. No transformation. The 
assumption is that this is an internal extension. The timer forces Bria Professional to wait after 
detecting a three-digit number beginning with 3, in case you are actually dialing a local call 
starting with 3. 

1xxxxxxxxxx The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial as is. 
The assumption is that this is a long-distance PSTN call within North America (within North 
America, all long-distance calls start with 1).

[2-9]xxxxxxxxx The third pattern is any ten-digit number beginning with a number other than 1. The 
assumption is that this is a local PSTN call within a ten-digit dialing zone. 

+x.T; The fourth pattern is a number of any length that begins with +, to indicate an international 
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access 
an international line from North America).

match=2;pre="9"; For the second pattern, prefix 9 to access an outside line.

match=3;pre="91"; For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;
pre="9011"

For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the 
international code.

#1xxxxxxxT The pattern is an account prefix followed by seven digits. The timer forces Bria Professional 
to wait to allow a match to the second pattern. The #1 is stripped off and 9 is prepended to 
access an outside line.

#19xxxxxxx The pattern is an account prefix followed by a 9 and seven digits. The #1 is stripped off.

xxxxxxxT The pattern is seven digits. The timer forces Bria Professional to wait to allow matching to 
the fourth pattern. 9 is prepended to access an outside line.

9xxxxxxx The pattern is a 9 and seven digits. The input is not transformed.
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However, the example does illustrate two ideas:

• Handling of the account prefix (#1), if you are upgrading from eyeBeam and are accustomed to entering the 
account number. 
Use of # to identify the account is now deprecated. The dial plan should be capable of determining the 
account to use for this number. However, since users may still be in the habit of entering the account prefix, 
you may want to include this pattern to handle such a scenario.

• Distinguishing between a local seven-digit call in which 9 is not dialed (to access an outside line) and one 
in which 9 is dialed to access an outside line. 
44



Bria Professional Administrator Guide
C Contact List Headings
Following is a list of all the headings that are used in the Bria Professional contact list. This list can be useful 
when formatting a contact list in order to import it into Bria Professional. For details, see “Creating a Contact 
List” on page 8.

uri business_number sms_addresss

display-name business_number2 ms_address2

entry_id business_number3 sms_address3

given_name business_number4 sms_address4

surname business_number5 sms_address5

email_address business_number6 sms_address6

email_address2 mobile_number custom_fields

email_address3 mobile_number2 custom_fields2

email_address4 mobile_number3 custom_fields3

email_address5 mobile_number4 custom_fields4

email_address6 mobile_number5 pres_subscription

sip_address mobile_number6

sip_address2 fax_number

sip_address3 fax_number2

sip_address4 fax_number3

sip_address5 fax_number4

sip_address6 fax_number5

home_number fax_number6

home_number2 groups

home_number3 comment

home_number4 postal_address

home_number5 default_address

home_number6 default_address_type
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D Glossary
AEC Acoustic echo cancellation. Processing of the audio or video signal to reduce the echo 

effect that can arise with a speakerphone or that can arise if the sound from the 
speakerphone or headphone leaks into the microphone. 

AGC Automatic gain control. Processing of the audio or video signal to adjust the 
microphone volume level so that the other party does not hear the distortion that 
might be caused by too high a microphone input or too low volume (due to too low 
input level).

AVI Audio Video Interleave. A multimedia container format. AVI files contain both audio 
and video data in a standard container that allows simultaneous playback.

Broadband Broad or wide bandwidth. In data transmission, the wider the band, the more data it is 
possible to transmit in a given time span. A cable, DSL and ADSL connection to the 
network provide broadband for data transmission. A dialup or ISDN connection 
typically provide a narrow bandwidth for data transmission.

Codec The format by which audio or video streams are compressed for transmission over 
networks.

Dial plan The rules that Bria Professional follows in order to interpret the softphone address or 
phone number that the user has entered and to modify the number or address, as 
required, to ensure that the call will be placed successfully. 

DTMF Dual-tone multi frequency. DTMF is the system that is used in interactive voice-
response menu systems such as the menu system for accessing voicemail messages. 
The DTMF system allows the user to interact with the menu by pressing keys on a 
dialpad or keyboard.

IM Instant Messaging. A technology that lets users send text message and files for near 
instantaneous delivery and display on each others’ computers.

IP Internet Protocol. A data-oriented protocol used for communicating data across a 
network. IP is the most common protocol used on the internet.

IP address A unique number that devices use in order to identify and communicate with each 
other on a computer network using the IP standard. 

Media In a VoIP phone call, the audio and video portion of the information in a call. 
Compare to “Signaling”.

MWI Message Waiting Indicator. An indicator that there is a voicemail message for the 
owner of an account.

Narrowband In data transmission, the wider the band, the more data it is possible to transmit in a 
given time span. A cable, DSL and ADSL connection to the network provide 
broadband for data transmission. A dialup or ISDN connection typically provide a 
narrow bandwidth for data transmission.

Presence An instant messaging feature that allows users to share information about their 
availability, mood, location and so on.

Proxy See SIP account.
PSTN Public Switch Telephone Network. The traditional land-line phone network.
RFC Request for Comment. A document that describes an aspect of an internet technology. 

An RFC may be a proposed, draft or full internet standard.
RTP Real-time Transport Protocol. A protocol for delivering the media portion of a data 

transmission over an IP network. SRTP is another media protocol.
Signaling In a VoIP phone call, the information in a call that deals with establishing and 

controlling the connection, and managing the network. The non-signaling portion of 
the call is the Media.
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SIMPLE protocol Session Initiation Protocol for Instant Messaging and Presence Leveraging 
Extensions. The instant messaging (IM) protocol followed by Bria Professional. It 
encapsulate the rules for exchanging instant messages.

SIP Session Initiation Protocol. The signaling protocol followed by Bria Professional for 
handling phone calls. 

SIP account An account that provides the user the ability to make VoIP phone calls. The account 
encapsulates the rules and functions the user can access.

softphone address The address used to connect to a SIP endpoint. In other words, the “phone number” 
used in a VoIP phone call. For example, sip:joseph@domainA.com.

SRTP Secure Real-time Transport Protocol. A protocol for delivering the media portion of a 
data transmission over an IP network. SRTP is a secure protocol, which means that 
the media is encrypted. RTP is another media protocol.

TCP Transmission Control Protocol. A transport protocol for delivering data over an IP 
network. Other transport protocols are TLS and UDP.

TLS Transport Layer Security. A transport protocol for delivering data over an IP network. 
TLS is a secure transport protocol, which means that all the data being transmitted 
(signaling and media) is encrypted. Other transport protocols are TCP and UDP.

UDP User Datagram Protocol. A transport protocol for delivering data over an IP network. 
Other transport protocols are TCP and TLS.

URI Uniform Resource Identifier. A name or address that identifies a location on the world 
wide web. A softphone address is a type of URI.

URL Uniform Resource Locator. A URI that both identifies a name or address and indicates 
how to locate it. 

USB device Universal Serial Bus device. A device that follows a specific communications 
standard. A headset may be a “USB type” of headset. 

VAD Voice Activity Detection. A technology that detects if audio is a human voice or 
background noise. Bria Professional includes a feature (Preserve bandwidth on the 
Network panel of the Preferences window) that controls whether audio is transmitted 
when VAD determines that none is actually speaking.

vCard An electronic business card that is often attached to an email. It often appears as a 
“signature” block that identifies the person, their title, and their business.

VoIP Voice over Internet Protocol. A variation of IP used for sending voice data over the 
internet, in other words, used for making phone calls over the internet.

VoIP service provider A business that provides a VoIP service, allowing a user to connect to the internet in 
order to make VoIP phone calls using Bria Professional. The VoIP service provider 
sets up a SIP account for the user. 

WAV Or WAVE. A file format standard for storing audio on PCs.
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